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Trademarks 

The following are registered trademarks of Motorola:  SmartZone, SmartNet, ASTRO®.  

 

Any other brand or product names are trademarks or registered trademarks of their respective holders.  

The Genesis Group Trademark Information 

GenWatch3® is a registered trademark of GenCore Candeo, LTD., a subsidiary of Burks Gencore Co., Inc. 

D.B.A. The Genesis Group and Phil Burks.  

Copyright 

Copyright © 2011; Burks Gencore Co., Inc. D.B.A. The Genesis Group and Phil Burks.  All rights are 

reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, 

in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, 

manual or otherwise, without the prior written consent of Burks Gencore Co., Inc. D.B.A: 

The Genesis Group and Phil Burks 

601 Shelley Dr., Suite 202 

Tyler, Texas 75701. 

 

Includes technology licensed from Motorola. 

Disclaimer 

The GenWatch3 Users Manual is printed in the U.S.A. Burks Gencore Co., Inc. D.B.A. The Genesis Group 

and Phil Burks believe that the information included in this manual is correct; however, Burks Gencore Co., 

Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make periodic changes 

to the manual and its contents. Burks Gencore Co., Inc. D.B.A. The Genesis Group does not assume 

responsibility to notify any person of such revisions or changes. While we have taken strides to carefully 

examine our software and documentation and believe that it is reliable, the Genesis Group and Phil Burks 

assume no responsibility for the use of the manual, or GenWatch3 software, nor for any patent infringements 

or other rights of third parties who may use the manual or the GenWatch3 software. Burks Gencore Co., Inc. 

D.B.A. The Genesis Group and Phil Burks make no representations or warranties with respect to the contents 

or fitness for a particular purpose beyond the cost of the software paid by the end-user. 

 

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or 

software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed 

these statements. 

License 

Title to the media on which the program is recorded and to the documentation in support of the product is 

transferred to you, but title to the program, and all subsequent copies of the program, despite the form or 

media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the 

selection of the program to achieve your intended results, and for the installation, use, and results obtained 

from the program. 

 

Refer to the GenWatch3 Manual Overview for your full license.  All license information contained on pages 

4-7 (Book 600-2.3.0-AA.1) are to be considered as contained herein. 

Support 

Customer satisfaction is our number one priority at Genesis.  We are here to provide you with the best 

software possible, and we want to know when you have any questions, concerns or problems with 

GenWatch3 so that we can make it better a product for everyone.   

 

Refer to the Troubleshooting & Support section of the GenWatch3 Manual Shell (Book 600-2.3.0-AA.1) for 

complete support and contact information. 
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About this Manual 

 

Goals 

This manual describes the role and function of the GW_Reports module in the 

GenWatch3 solution. 

Who Should Read This Manual? 

This manual is written for the intended audience of novice to mid-level Motorola 

trunked radio system users and novice to mid-level PC users. 

How This Manual Is Organized 

This manual is organized as follows: 

 Overview:  Gives a general overview of the GW_Reports GUI (graphical 

user interface). 

 Using GenWatch3 Database Reports:  Describes the process of running 

a GenWatch3 database report. 

 Excel Workbooks for GenWatch3 Database Reports: Describes how 

GW_Reports uses integrated Microsoft Excel workbooks. 

 Using GenGET Reports:  Describes the processes of running GenGET 

reports. 

 Excel Workbooks for GenGET Reports:  Describes how GW_Reports 

uses integrated Microsoft Excel workbooks. 

 

This manual contains the following images, used to indicate that a segment of text 

requires special attention: 

  Additional Information:  Additional information is used to indicate 

shortcuts or tips. 

  Warning:  Warnings are used to indicate possible problem areas, 

such as a risk of data loss, or incorrect/unexpected functionality. 
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Note about Daylight Saving Time Change 

NOTE:  If a call is in process when the time changes in the host machine‘s time 

zone for daylight saving time, and if you are running a report that includes that 

call, you WILL see unusual call lengths. The time and date stamp for all calls 

comes from the computer that is hosting the GenWatch3 archive database. As 

such, when Windows automatically changes the time, a call in process could 

appear to be excessively long or even could have negative time. This is isolated 

only to calls occurring at exactly 2:00AM on the day that the time moves forward 

or backward by one hour. If you have this situation and if you need help getting a 

report to come out correctly, contact Genesis for assistance. For more information 

on daylight saving time, please see: 

http://aa.usno.navy.mil/faq/docs/daylight_time.php 

 

 

 

 

http://aa.usno.navy.mil/faq/docs/daylight_time.php
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Chapter 1 Overview 

 
 

This chapter describes the GW_Reports GUI and gives an overview of the options 

available in the GW_Reports GUI. 

 

  
Figure 1.1 – GW_Reports GUI 

 

1 – Report List:  This list shows all GenWatch3 Reports and all Excel 

Workbooks saved to the Reports directory under the GenWatch3 installation 

directory. 

2 – Report Description:  Shows the description of the selected report (if 

available).  Shows nothing if a workbook saved to the Reports directory under the 

GenWatch3 installation directory is selected. 

3 – Data Source:  Shows the current reporting data source as [Database Server 

Name]→[Database Instance Name].  Double-click this label to change the 

GW_Reports data source.  This data source only applies to GenWatch3 database 

reports (described in the Report Varieties section below). 

4 – Refresh Reports Button:  Refreshes the reports list. 

5 – Close Button:  Closes the GW_Reports GUI. 

1 

2 

3 4 5 
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Report Varieties 

The GW_Reports license allows for two types of reports: 

 GenWatch3 Database Reports:  These reports use data archived by 

GenWatch3.  If your GenWatch3 installation is archiving data (includes 

the GW_Archiver module), please refer to Chapter 2 Using GenWatch3 

Database Reports for instructions on using GW_Reports.  There are two 

categories of GenWatch3 database reports: 

o Core Reports:  These reports are included as a part of the 

GW_Reports option 

o Premium Reports:  These reports are purchased individually as a 

supplement to the core reports. 

 GenGET Reports:  These reports report on the data archived by 

GenGET.  If your Genesis solution includes GenGET, please refer to 

Chapter 4 Using GenGET Reports for instructions on using GW_Reports.  
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Chapter 2 Using GenWatch3 Database Reports 

 
 

This chapter contains the following sections: 

 Terms:  Describes terms that are used in GenWatch3 database reports. 

 What are GenWatch3 Database Reports?:  Describes the GenWatch3 

database reports. 

 Data Source:  Describes the GW_Reports data source and how to change 

it. 

 Report Files:  Describes the location and function of the files used within 

GW_Reports. 

 Core Reports:  Lists and describes the core reports included with 

GW_Reports. 

 Premium Reports:  Lists and describes the premium reports offered for 

GW_Reports. 

 Reporting Overview:  Provides a walkthrough of running a GenWatch3 

database report. 

 Using the Report Wizard:  Describes the Report Wizard and how to 

define report parameters and generate a report. 

 Advanced Reporting Options:  Discusses options available for advanced 

reporting. 

Terms 

 Parameters:  Reporting options chosen within the GW_Reports Report 

Wizard.  These include date/time, locations, agencies, radio IDs, 

talkgroups, etc. 

 SQL Database Connection:  Allows you to view data in the SQL 

database.  Requiring a connection ensures that only valid users are allowed 

to view your data. 

 SQL Query:  A question asked of the database, such as, ―Which radio IDs 

issued activity between 1/1/2007 and 1/31/2007?‖  The GW_Reports 

Report Wizard builds an SQL Query behind the scenes as you select 

parameters. 

 Data Source:  Database used when executing a SQL query. 

 Drop-down List:  Fixed list of options from which you must choose 

exactly one option. 

 Parameter Grid:  List of options where you must select (click the 

checkbox in the Enable column of) one or more entries. 
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What are GenWatch3 Database Reports? 

GenWatch3 database reports provide information stored by the GW_Archiver 

module to the GenWatch3 database (GW).  Each GenWatch3 database report 

includes a Report Wizard to guide you through parameter selection.  GW_Reports 

uses your GenWatch3 user name and password to build an SQL database 

connection.  This connection is used to execute the SQL query defined within a 

report.  This SQL query includes the parameters you choose in the Report Wizard. 

Data Source 

GW_Reports allows you to specify a reporting data source (see Figure 1.1 section 

3).  The data source is comprised of two parts: 

 Database Server Name:  This is the name of the machine that is hosting 

the SQL Server database. 

 Database Instance Name:  This is the name of the GenWatch3 database 

within the SQL Server database.   

 

GenWatch3 archives data to the GW database instance on the database server 

name specified within the GenWatch3 database settings. For more information on 

your GenWatch3 database server, see the Changing Your GenWatch3 Server 

Settings section in chapter 6 of the GenWatch3 Core Manual.pdf file. 

 

To change your GW_Reports data source, follow the steps below: 

 

1. Double-click on the data source label. (See Figure 1.1 section 3):  This 

will show the Reports Login window.  

 

2. Click the  button:  This will show the Data Source Selector window. 

 

 
3. Enter a Database Server value. 
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4. Choose/Enter a Database Instance value.  This list contains the common 

GenWatch3 database instance names.  You can also type in an instance 

name. 

5. Click OK:  This will close the Data Source Selector window and return 

you to the Reports Login window. 

6. Enter the Password for the specified user name. 

7. Press Enter or click the OK button:  This will validate the specified User 

Name and Password against the specified data source. 

 

Report Files 

The Reports List is dynamically loaded on start up based on the existence of 

certain files in predefined locations.  The sections below describe these files in 

detail. 

Report Files 

Upon startup, GW_Reports fills its report list based on three things: 

1. The DLL files (files with a .dll extension) within the GenWatch3 install 

directory.   

 

  DLL File:  Each GW_Reports report has a corresponding DLL (dynamic linked library) 

file.  The GW_Reports DLL file includes the interfaces (windows) of the report‘s wizard and the 

Excel Spreadsheet template for the report. 

 

2. The Excel workbook files (XLS) that have been saved to the Reports 

directory under your GenWatch3 install directory.  

3. The Excel files (XLS, XLSX, XLSM, XLTX, XLTM) that have been 

saved in the current user‘s \My Documents\Genesis\GenWatch3\Reports 

folder.  

 

  This allows you to launch non-GW_Reports Excel files from the GW_Reports GUI.  Simply 

choose File, Save As to save an Excel Spreadsheet to the current user‘s 

\Documents\Genesis\GenWatch3\Reports folder. 
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Image Files 

The images shown in the Reports List are pulled from the Reports directory under 

your GenWatch3 data directory.  If an image (BMP, JPG, GIF or PNG) has the 

same name as a DLL file in the Reports\Binaries directory, then this image will 

be used for that report in the Reports List.  If an image (BMP, JPG, GIF or PNG) 

has the same name as an Excel file (XLS, XLSX, XLSM, XLTX, or XLTM file) 

in the \Reports directory (either under the GW3_TRBO install directory or 

user\Documents\Genesis\GenWatch3), then this image will be used for that Excel 

file.  This allows you to create and show images for any Excel files you add to the 

Reports directory.  If an image is not found for a DLL or an Excel file, then the 

default ―No Picture‖ image is shown for that item in the reports list. 
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Core Reports 

The following reports are included in the GenWatch3 GW_Reports list: 

 Activities By Agency Over Time:  Shows usage statistics by agency for 

each radio ID included in the report.  

 Activities By Radio Over Time:  Shows usage statistics for each radio ID 

included in the report. 

 Activities By Talkgroup Over Time:  Shows group statistics for each 

group included in the report. 

 Activities Over Time:  Shows group, private and telephone statistics for a 

given date range. 

 Busy Detail:  Shows activity from the busies table for the selected types 

of calls in the selected date range. 

 Call Activity:  Shows activity from the calls table for the selected types of 

calls in the selected date range. 

 Channel Activities:  Shows channel-based statistics for a given date range 

divided into the selected intervals. 

 Channel Usage:  Shows channel-based usage statistics.  

 Group PTTs:  Provides time and call count information about group 

PTTs. 

 Group Usage By Radio: Shows group usage summary for each radio ID.  

For private and interconnect calls, the usage is shown by the radio ID's 

default group. 

 Interconnect Usage:  Shows interconnect usage detail for a given date 

range. 

 Radio Activity:  Shows commands sent to radios and events received 

from radios as stored in the GW_Archiver database. 

 Radio Activity Detail: Shows all activity originated from or targeting the 

selected radio ID(s) determine site registration and talkgroup affiliation 

 Radio Affiliation:  This report shows detailed activity orginated by the 

selected radio ID(s).  Use this information to determine a radio ID's site 

registration and talkgroup affiliation. 

 Radio Commands: Shows event types for the specified radio ID(s) 

originated by the specific user(s) on the specified talkgroups for the 

specified time period. (Included with GW_Halcyon) 

 Radio Events:    Shows radio commands issued to the specified radio 

ID(s) from GW_RCM and GW_Halcyon CAD.  

 Radio PTTs:  Shows PTT counts for each selected radio ID(s) 

summarized by hour. 

 Radio State:  Shows the current state of the radio ID(s) selected. 

 Reject Reasons:  Shows reject reasons with details for a given date range. 

 System Diagnostics:  Shows system diagnostics for the given date range. 

 System Usage:  Shows four different reports and graphs summarizing 

usage on your system. 
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Premium Reports 

 Grade of Service:  Provides actual and statistic grade of service achieved 

within a specified time range. 

 LoneWorker Alarms: (Included with GW_LoneWorker) 

 LoneWorker Profiles: (Included with GW_LoneWorker) 

 Radio Discovery:  Shows usage summaries for all units and talkgroups on 

a system along with a report of what services/features each radio has ever 

used. 

 

 If one or more of the above reports are missing, you may not be licensed for the missing 

report(s).  Please contact GenWatch3 support for more information regarding your license or 

check your list of licensed reports under the GW_Reports module in the License Manager (see 

Chapter 7 of the GenWatch3 Core Manual) 
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Reporting Overview 

The Report List contains each GenWatch3 report located in your GenWatch3 

installation directory. It also includes each Microsoft Excel workbook that you 

have saved to the Reports directory under the GenWatch3 install directory.  This 

chapter‘s instructions only pertain to the GenWatch3 reports shown in the Reports 

List, not the Microsoft Excel workbooks that you may have added to the list. 

 

To load a report, follow the steps below: 

1. Load GW_Reports. 

2. In the Report List, double-click on the report that you wish to load:  This 

will show the Reports Login window. 

3. Enter the Password for your GenWatch3 login and click the OK button:  

This will load the Report Wizard for the selected report.  (Some wizards 

may take several seconds to load, due to the number of radio IDs, 

talkgroups, etc. in the GW_Alias database.) 

4. Choose the parameters for each page in the Report Wizard.  Click the Next 

> button to move to each next Report Wizard page.  On the last Report 

Wizard page, the Next > button will read Go to Summary… 

5. Click the Go to Summary… button:  This will load the Report Summary 

window.  This window summarizes the parameters that you have selected. 

6. Click the Run Report… button on the Report Summary window:  This 

will load the Excel workbook for this report and run the report query, 

including the parameters that you selected in the Report Wizard. 

7. While the query is running you will see the following spinning globe 

toward the bottom-right (bottom-left in Excel 2007) of the Excel 

workbook:  

8. Once the query completes, the globe will disappear and the Excel 

workbook will contain your query results. 

9. You may save this Excel workbook in an alternate location, print the 

workbook or simply close the workbook and discard the changes.  You 

can also minimize the workbook, return to the Report Wizard, change the 

parameters and run the report again. 
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Report Parameters 

The Excel workbook shows the parameters selected in the Report Wizard.  If your 

parameters included radio ID selection, the report will contain a Radio IDs tab.  

This tab will list each radio ID included in the query.  If your parameters included 

talkgroup selection, the report will contain a Talkgroups tab.  This tab‘s sheet 

will list each group included in the query.  All other parameters are shown in the 

header section of each sheet in the report.  These parameter tabs are shown with a 

light-blue background. 

Historical Alias Reporting 

Over time a radio ID‘s alias my change as ownership of the physical radio 

changes.  GW_Alias keeps track of the ending date and time of a radio alias, 

excluding the default GW$ aliases.   

 

Reports that show detailed information at the radio level (such as the Call 

Activity report) may transition between radio aliases to reflect the radio‘s alias at 

the time of the activity.  Reports that summarize activity on the radio level (such 

as the Radio PTTs report) may split a radio ID‘s summary to multiple lines to 

reflect changes in radio ID‘s alias somewhere in the date range of the report. 
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Using the Report Wizard 

Each report includes a Wizard to help you choose report parameters.  The goal of 

the Report Wizard (Figure 2.1) is to eliminate the need to type in report 

parameters.  Each parameter is selected from a drop-down list or a parameter grid. 

 

 
Figure 2.1 – GenWatch3 Report Wizard Window 

Common Report Wizard Elements 

Each Report Wizard contains some common elements found in all of the Wizards 

1. Report Title:  This title shows in the title bar of the form (blue section at 

the top of the form) 

2. Report Progress:  Where you are in the Report Wizard parameter 

selection process. 

3. Page Help:  Shown in the bottom right of the Report Wizard.  This box 

describes the current page. 

4. < Previous Button:  Allows you to move to the previous page. 

5. Next > / Go To Summary… button:  This button reads ―Next >‖ on 

every page but the last page.  On this page it reads Go to Summary…  

This indicates that clicking the Go to Summary… button will show the 

Report Summary window. 

6. Cancel:  Cancels the Report Wizard. 

7. SQL… button:  When you navigate to the last page this button appears 

on the Report Wizard just above the Report Progress label.  Clicking this 

button will show the SQL query used to execute the report. 

8. Report Summary:  Shows a summary of parameters you selected in the 

Report Wizard (See Figure 2.2). 

 

1 

2 

3 4 5 6 

7 
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Figure 2.2 – Report Summary Window 

 

Report Wizard Attachments and Group Filters 

The Report Wizard filters the selection choices for radio IDs and talkgroups by 

the Group Filter set up for your GenWatch3 user in the GW_Security GUI.  The 

Talkgroups grid will only contain talkgroups in the user‘s Group Filter.  The 

Radio IDs list will only contain talkgroups that have a Default Group of one of 

the talkgroups in the user‘s Group Filter. 

 

For example, if your user has access only to talkgroup 1, you will not see 

talkgroup 5 listed as a selection choice in the Talkgroups grid. 

 

If a user‘s role is granted the ViewAllGroups privilege for the GW_Reports 

module in the GW_Security GUI, he or she will be able to see all talkgroups and 

radio IDs, regardless of his or her attachment list. 
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Report Wizard Grids and Filtering 

Most of the Report Wizard parameters contain at least one grid similar to Figure 

2.3.  These grids contain selection choices for a particular parameter, such as 

System, Zone, Site, Talkgroup, Radio ID, etc.  In some cases, selecting an item on 

a grid will add more items to another grid.  In the case of Location and Agency 

selection, the Agency grid will initially have no entries.  As you select (click the 

box in the Enable column) Locations, the Report Wizard will add Agencies under 

the selected Locations to the Agency grid.  If you come to a window that contains 

a grid and the grid does not hold all of the values you expect to see, make sure 

that a selection on a grid on a previous page is not required to provide the 

―missing‖ values. 

 

 
Figure 2.3 – Radio ID Selection Grid 

 

If a grid only contains one item, this item will automatically be selected.  This 

feature keeps you from having to click on a grid item when there is no actual 

decision to make. 

 

Each Report Wizard grid provides a Select All and an Unselect All button.  The 

Select All button selects each item in the grid, while the Unselect All button 

unselects each item in the grid. 
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Grid Filtering 

Some grids can potentially contain thousands of items.  The following grids 

provide a filter option to narrow the list of items and make item selection easier: 

 Channels 

 Radio IDs 

 Talkgroups 

 

 
Figure 2.4 – Radio ID Selection Grid Filter 

 

The filter option contains the following options, shown in Figure 2.4: 

1. Column List:  This control contains a selectable list of grid columns.  

This is where you select the column you wish to filter on. 

2. Parameter Text:  This control contains the text used to filter the results.  

Press Enter on this control to apply the filter to the grid.  Any item 

containing the Parameter Text will be shown in the filtered list.  This 

means that if you select Radio ID from the Column List and enter a 

Parameter Text of ‗1‘ only radio IDs containing the number one will be 

shown.  i.e. 1, 10, 210, etc.  If you select Alias from the Column List and 

enter a Parameter Text of ‗am‘ only Aliases containing the letters ‗am‘ 

will be shown.  i.e. James, Amber, 8030AM, etc. 

3. Clear Button:  This button removes the filter from the grid.  Press this 

button to show all items in the grid. 

 

To filter a grid, follow the steps below: 

1. Choose a column from the Column List. 

2. Type your filter into the Parameter Text. 

3. Press Enter while the cursor is in the Parameter Text box:  This will 

apply your filter to the grid. 

 

  Report Wizard grid selections are exclusive.  This means that if you select talkgroups 1, 3 

and 5 in the Talkgroups grid and 1, 2, 3 in the Radio IDs grid, then the report will only include 

activity that occurred for radios 1, 2 or 3 on groups 1, 3 or 5.   

 

  If you wish to report on activity for a range of groups, select the talkgroups in the 

Talkgroups grid and select all radio IDs in the Radio ID grid.  If you wish to report on all activity 

for a range of radio IDs, select the radio IDs in the Radio IDs grid and select all groups in the 

Talkgroups grid.  This same approach can be taken for all Report Wizard grids. 

 

1 2 3 
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Other Report Parameter Types 

In addition to grids, the Report Wizard uses the following methods of parameter 

selection, shown in Figure 2.5: 

 Date Range:  This control consists of two date and time selector controls.  

The From date and time is the start of the date/time range, while the To 

date and time is the end of the date/time range.  This control also contains 

date range shortcuts such as Yesterday and This Week.  Click on a link to 

auto-fill the selected range. 

 

 
Figure 2.5 – Date Range Parameter 

 

  Although it is not shown in the From date range, the From date range second value is 

always 0.  Although it is not shown in the To date range, the To date range second value is always 

59.  These implied values ensure that your report includes all seconds within the selected minutes. 

 

 Report Type:  This control (Figure 2.6) allows you to select the detail of 

the report.  The selections include: 

o Summary:  Each row in the report shows the usage of the 

frequency, group, radio ID, etc., summarized for the entire 

date/time range. 

o Daily:  Each row in the report shows the usage of the frequency, 

group, radio ID, etc., for each day in the date/time range. 

o Hourly:  Each row in the report shows the usage of the frequency, 

group, radio ID, etc., for each hour in the date/time range. 

o Quarter-Hourly:  Each row in the report shows the usage of the 

frequency, group, radio ID, etc., for four 15-minute increments in 

the date/time range.  These increments are 0, 15, 30 and 45. 

 

 
Figure 2.6 – Report Type Parameter 
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 Check Boxes:  These controls allow you to indicate a yes/no selection.  

Some reports will use these for inclusive decisions (i.e. ―include this 

option in the report as well‖) or for exclusive decisions (i.e. ―only include 

what I have selected in the report‖).   The Help window of the report will 

tell whether the check boxes are inclusive or exclusive. 

 

 
Figure 2.7 – Check Box Parameter 

 

Advanced Reporting Options 

Because GenWatch3 uses Microsoft Excel workbooks, you can go beyond the 

reporting offered in the GW_Reports GUI.  There are many third party programs 

and applications (purchased from vendors other than Genesis) that can be used to 

write reports on the GenWatch3 database.  The data in the GenWatch3 database is 

YOURS and you should be able to report on it as you wish. 

 

Contact GenWatch3 support to receive the structure of the GenWatch3 database.  

This will define the tables in the GenWatch3 database and all fields in these 

tables. 
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Chapter 3 Excel Workbooks for  
GenWatch3 Database Reports 

 
 

This chapter describes how GW_Reports uses integrated Microsoft Excel 

workbooks.  This chapter also describes how to alter these workbooks and how to 

revert back to the original workbook. 

 

This chapter contains the following sections: 

 Overview:  Describes how GW_Reports uses Microsoft Excel to run and 

display report queries. 

 Customizing a Workbook:  Describes how to customize a Microsoft 

Excel workbook template. 

 Reverting Back to an Original Template:  Describes how to revert back 

to an original GW_Reports Excel workbook template. 

Overview 

The GW_Reports module uses Microsoft Excel to run and display report queries.  

Each report binary (DLL) contains its Excel report template.  When you run a 

report for the 1
st
 time, GW_Reports creates a copy of this Excel workbook in the 

Reports directory under the GenWatch3 installation directory.  This copy of the 

Excel workbook is the template used to generate the Excel workbook for the 

report. 

 

  These Excel files are used as templates, but they have the normal .xls extension.  They do 

not have the .xlt extension experienced Excel users may expect. 
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Customizing a Workbook 

You may wish to customize the GW_Reports report workbooks.  Customization 

may include your company‘s logo, different color schemes, etc.  To customize a 

report template, simply make changes to the report template saved in the \Reports 

directory under the GenWatch3 installation directory.   

 

Each report contains two things that are altered by GW_Reports every time you 

run the report. 

 Report parameters:  Report parameters are shown in cells with light blue 

backgrounds (Figure 3.1).  These cells show the parameters selected while 

using the Report Wizard. 

 

 
Figure 3.1 – Workbook Report Parameters 

 

 Query Tables:  Query tables are the tables that show the actual report 

results.  Query tables are shown below the parameters section and have dark 

blue background and white text (Figure 3.2). 

 

 
Figure 3.2 – Workbook Query table 

 

The location of each of the items mentioned above are stored within each Excel 

workbook, on a hidden sheet named ―Parameters.‖  If your customization moves 

the cell positions of parameters or query tables, then you must update the 

Parameters sheet with the new cell positions.  To do this, you must unhide the 

hidden parameters sheet.  To unhide this sheet: 

1. In Microsoft Excel , choose Format->Sheet->Unhide:  This will show a 

dialog containing the Parameters sheet. 

2. Click OK:  This will show the Parameters sheet in the tabs along the 

bottom of the Microsoft Excel workbook. 

 

Once you are satisfied with your report changes, you may hide the parameters 

sheet by clicking Format->Sheet->Hide while the Parameters sheet is selected. 
 

  The \Reports folder under GenWatch3 installation directory should only contain GenWatch 

reports that have the .xls extension. If saving in any other supported excel format the files should 

be placed in the Current User‘s \Documents\Genesis\GenWatch3\Reports directory. 
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Filtering Report Results 

You will notice that each column in the Microsoft Excel query table contains a 

drop-down list (Figure 3.3).  This list contains column-based filtering options.  

You can add one or more conditions to each column.  Only the rows whose values 

satisfy these conditions will be shown on the report.  Each time the report is 

refreshed (each time you run the report) these filters are reset. 

 

 
Figure 3.3 – Workbook Filter Options 

 

  If you apply report filters, the column totals (shown in the last row of the report results) may 

or may not be indicative of the filtered report results.  In some cases, filtering will filter out the 

total row.  

Reverting Back to an Original Template 

If you have customized a GW_Reports template and wish to revert back to the 

original report template, delete the report template from the Reports directory 

under the GenWatch3 installation directory.  The next time you run this report, 

GW_Reports will recreate the template. 

 

  When deleting the template, be careful not to delete any files with a .dll extension.  Only 

delete files with a .xls extension 

 

  You can also rename the report template, if you want to preserve the template you are 

replacing. 
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Chapter 4 Using GenGET Reports 

 
 

Terms 

 Parameters: Reporting options chosen within Parameters tab of the Excel 

file. These include date/time, site, zones, radio IDs, talkgroups, etc. 

 Sql Database Connection:  Allows you to view data in the SQL database.  

Requiring a connection ensures that only valid users are allowed to view your 

data. 

 SQL Query: A question asked of the database. Such as, ―Which radio IDs 

issued activity between 1/1/2009 and 1/31/2009?‖ Excel builds an SQL query 

behind the scenes when you select parameters. 

What is GW_Reports? 

GW_Reports is a reporting application used to execute GenGET reports. Each 

report includes a parameters tab to guide you through parameter selection. 

Parameters are the filters or choices you make when building the report. 

GW_Reports uses an ODBC connection from your PC to build an SQL database 

connection. This connection is used to execute the SQL query defined within a 

report. This SQL query includes the parameters you choose in the Parameters 

Tab of the Excel file. 

 

  If you do not have an ODBC connection setup named ―GenGET_DB‖, 

please see the document titled GET QRG Master.pdf on your GenGET documentation CD. 
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Report Files 

The Reports List is dynamically loaded on start-up based on the existence of 

certain files in predefined locations. The sections below describe these files in 

detail. 

Excel Workbook 

Upon startup, GW_Reports fills its report list based upon Excel files in the 

Reports directory under your GenWatch3 install directory as well as reports in 

your \Documents\Genesis\GenWatch3\Reports folder. 

 

  This allows you to launch Excel files from the GW_Reports GUI. Simply choose File -> 

Save As to save an Excel Spreadsheet to the current user\Documents\Genesis\GenWatch3\Reports 

folder (reports are ―Read Only‖ to avoid accidental overwrites). 

Image Files 

The images shown in the Reports List are pulled from the Reports directory under 

your GenWatch3 data directory. If an image (BMP, JPG, GIF or PNG) has the 

same name as an Excel file (XLS, XLSX, XLSM, XLTX, or XLTM file) in the 

Reports directory (either under the GW3_TRBO install directory or 

user\Documents\Genesis\GenWatch3), then this image will be used for that Excel 

file. This allows you to create and show images for any Excel files you add to the 

Reports directory. If an image is not found for a DLL or an Excel file, then the 

default ―No Picture‖ image is shown for that item in the reports list. 
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Core Reports 

The following GenGET reports are typically included in the GenWatch3 

GW_Reports list: 

 Abnormal End of Calls:  Shows call activity for all calls that have an 

ATIA end reason outside of the following ―normal‖ list (18, 88, 89, 162, 

163, and 196).  Consult your ATIA documentation or your GenGET 

manual for a complete list of end call reasons. 

 Airtime and PTTs per Hour:  Shows subtotals of airtime and PTTs for 

each hour in the selected range. 

 Airtime by Minute:  Shows subtotals of airtime and PTTs for each 

minute selected (1, 5,10,15,30 or 60 minute segments – user selected). 

 Airtime by Radio ID:  Shows total of airtime and PTTs for each radio ID.  

You can see all IDs or a range of IDs. 

 Alias Information (Site, Group, Radio):  Shows a listing of all sites, 

talkgroups and radios that have been used on the system.  Includes aliases 

and additional information on radios and groups. 

 Average PTT Length and PTTs per Minute:  Shows average PTT 

length and number of PTTs for each hour in the specified time range. 

 Busy Seconds by Hour:  Shows busy seconds (all types) by hour for the 

specified time range. 

 Busy Seconds by Type:  Shows busy seconds for each ―busy type‖  

during the specified time range. 

 Call Activity:  Shows a detailed call list of each call for the specified time 

range.  Details include: date/time, call type, source site, target, duration, 

status, DIU, DBL, etc.  (Each line represents a call if using Message 

Trunking, or PTTs would be shown if using Transmission Trunking) 

 Call Activity Under 1 Second:  Shows same information as Call Activity, 

but limits results to calls with a duration of 1 second or less. 

 Detailed Busies:  Shows details for each ―busy‖ that occurred during the 

specified time range.  Details include the busy and source site of the 

call(s). 

 Detailed DIU Use:  Shows detailed usage data for all DIUs and DBLs 

during the specified time range. (not applicable to Dimetra or P25 

installations) 

 Detailed Site Use:  Shows individual PTT use for each site during the 

specified time range.  Similar to Call Activity, but PTT-based and includes 

the channel used.  Particularly useful for diagnosing issues within a 

specific site. 

 Emergencies by Talkgroup:  Shows quantity of emergency calls by 

talkgroup for the specified time range. 

 Events by Type:  Shows selected event types for the specified time range.  

This report has two tabs of Parameters. 
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 Group PTTs and Airtime by Hour:  Shows average PTT length and 

number of PTTs only for group calls during the specified time range. 

 Private PTTs and PTT Airtime by Hour:  Shows average PTT length 

and number of PTTs only for private calls (Radio to Radio) during the 

specified time range. 

 Radio Activity by ID:  Shows a detailed list of calls, affiliations, events 

and other items of a selected radio ID during the specified time range. 

 Radio Rejects:  Shows a detailed list of radio rejects and reject reasons 

for the specified time range. 

 Site Affiliation Summary:  Shows quantity of radios last known to have 

been affiliated with each site for the specified time range (summary by site 

and detail tabs).  This report does not account for de-registrations/de-

affiliations.  It is last known registration/affiliation. 

 Site Channel Summary:  Shows summary information about 

Site/Channel use for the specified time period.  (includes PTTs, airtime 

used, busies, etc.) 

 Site Utilization - GoS with Auto Busy Hour:  Grade of Service report 

showing summarized activity for each site‘s busiest hour of the specified 

time range (one line per site). 

 Site Utilization - GoS:  Grade of Service report showing summarized 

activity for the hour chosen by the report user (one line per site). 

 System Activity:  Shows a detailed, time-ordered look at system activity 

including calls, individual PTTs, failed calls (rejects), busies, affiliations, 

and much more.  This will emulate the GW3 Activity window for a 

historical segment of time (intended for small time segments). 

 Talkgroup Affiliation Summary:  Shows quantity of radios last known 

to have been affiliated with each talkgroup for the specified time range 

(summary by TG and detail tabs).  This report does not account for de-

registrations/de-affiliations.  It is last known registration/affiliation only. 

 Talkgroup Usage Top 20 by Hour:  Shows ―group‖ usage for the 20 

highest usage talkgroups for the specified time range. 

 Total Airtime for 24 Hours:  View system usage for a 24-hour period on 

the face of a clock. Also shows ―day‖ view and ―night‖ view for the 

specified time range. 

 Total Airtime Top XX Talkgroups:  Shows ―ALL‖ usage for the 

quantity of highest usage talkgroups you select during the specified time 

range.  This allows the user to select the total number of talkgroups to be 

considered. 

 Unit PTTs by Talkgroup:  Shows quantity of PTTs for the specified 

talkgroup during the selected time range. 
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Chapter 5 Excel Workbooks for GenGET Reports 

 

Running GenGET Reports 

In a Nutshell 

Reports are part of the ―human‖ interface to GenGET.  They make practical use 

of all the statistics collected and stored by GenGET.  

 

GenGET Reports are Excel files.  Therefore, you need Excel 2003 or better (2000 

is acceptable, but you may have issues with ―look and feel‖).  You also need an 

ODBC connection to the GenGET database (see appendices ―Creating an ODBC 

Connection‖).  If installed with GW3-NV, this connection should have been 

created automatically. 

 

All images and references in this document were created using Excel 

2003. 
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Running a Report 

At this point, you should have your GenGET system up and fully operational. 

 

You may access the reports via either of the following methods: 

 

 If you are in GenWatch3-NetVista, you can select Reports from the 

module icons on LaunchPad—just launch Reports and then double click 

which report you‘d like to run. 

 By browsing directly to a folder which stores the Excel files and then 

double clicking the file. 

 

Date/Time Formats:  When Excel opens the report, it will automatically change the 

date/time format to match that of your computer‘s ―Regional and Language‖ settings found in 

Control Panel. 

 

Macros:  Macros are required for the reports to work properly.  If you run reports from 

within the GW3-NV reports menu, this will automatically allow the macros to run.  If you 

decide to run reports manually, you will need to ensure your Excel macro settings are adjusted 

accordingly. 

Brief Overview of Excel Report Workbooks 

The Excel reports have multiple ―Tabs‖ located in the bottom left of your 

Microsoft Excel Window. The following explanations reference the tabs in Figure 

5.1.  

 

 
Figure 5.1 – GenGET Report Tabs 
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Parameter Tab 

 

 
Figure 5.2 – Parameter Tab 

 

1. The Parameters tab, shown in Figure 5.2, will have a brief description of 

the report. 

2. User Parameters – The user can change any of the fields highlighted in the 

light blue color.  Changes made to any fields not highlighted in light blue 

will be ignored during report generation. 

3. The buttons to the right of the Start Date and End Date have the following 

functions (in order from left to right): 

 Today (insert today‘s date at midnight) 

 Now (inserts the current date and time from your computer) 

 +1 Day (adds one day to the value in the field) 

 -1 Day (subtracts one day to the value in the field) 

 +1 Hour (adds one hour to the value in the field) 

 -1 Hour (subtracts one hour to the value in the field) 

 The button immediately after the words ―End Date‖ will copy the 

―Start Date‖ into the ―End Date field, which can then be easily 

manipulated with the other buttons. 
Note:  You can always type directly in the date entry fields as well. 

4. Excel reports created by Genesis will have a ―Generate Report‖ button 

which, when clicked, will place the data into the report from the GenGET 

database.  This process will take varying amounts of time depending on 

the report complexity and date range.  A status indicator shows that the 

query is still processing in Excel.  Please see “Note 1” at the end of this 

section for an example. 

 

The Data tab will always contain the raw data matching your request.  It can be 

sorted and filtered as any other Excel data. 
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Data Tab(s) 

Many of the reports include a graphical representation of the data.  One important 

note about the ―density‖ of some of the charts:  Some reports will need to have the 

data parameters closely contained in order for the charted data to be ―readable.‖  

If you cannot make out the data on your chart, we suggest changing the 

parameters to include less time or fewer zones/sites/talkgroups/etc. 

Chart Tab(s) 

Many reports have a chart tab.  The presence of these varies from report to report 

based on the logical display of data.  You may add custom charts to your copies 

of reports and/or modify the charts included in ours. 

SQL Tab 

This tab contains the raw SQL query that was sent to SQL Server to pull your 

report. You can learn from these to build your own custom queries if you wish. 

Help Tab 

Each Help tab contains a complete description of the fields included in your 

report that may not be perfectly clear (for example, we do not usually define 

“Radio Alias”).  In some cases, they may contain a small helpful ―note‖ about a 

specific detail.  We recommend looking at the Help tab in every report at least 

once to ensure you have all pertinent information. 
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Notes on Reports…  

Note 1 – While your query is running, you will see a small Globe in the bottom 

status bar area (Figure 5.3).  This globe will ―spin‖ while waiting on the query to 

return data from SQL. 

 

 Be aware that execution of the ―Generate Report‖ button on the Parameters tab will 

automatically change your active tab to the Data tab.  The time it takes will depend on your 

database size and the data range of your query.  In any case, the amount of time required should be 

no more than a few minutes. 

 

 
Figure 5.3 – Query Loading 

 

Note 2 – You may get the error in Figure 5.4 if your query is ―too big‖ for Excel.  

Excel 2003 can only display slightly over 65,000 rows of information. If you 

query causes this error, try it again with a smaller date/time range. 
(Excel 2007 changes this limitation to 1 Million rows, but you must first save the 

report in an Excel 2007 document format before you can achieve this ability.) 

 

 
Figure 5.3 – Excel Error 
 


